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COMFOCUS CORPORATION MAKES NO WARRANTY OF ANY KIND WITH 
REGARD TO THIS MATERIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.  ComFocus shall not be liable for errors contained in this documentation 
or for incidental consequential damages in connection with the furnishing, 
performance or use of this material. 
 
 
 
 
Copyright  1994 ComFocus Corporation.  All rights reserved. 
This manual and the SoftWave software may not, in whole or in part, be reproduced, 
copied, translated or reduced to electronic or machine readable form without prior 
written consent from ComFocus Corporation. 
 
Maps  Cartesia Software. 
The maps incorporated into this product are derived from images copyrighted by 
Cartesia Software, Inc.  These images are used here under a non-exclusive 
licensing agreement between ComFocus Corporation and Cartesia Software.  
Cartesia Software, 5 South Main Street, PO. Box 757, Lambertville, NJ 08530   (609) 
397-1611. 
 
SoftWave, ComFocus, SoftWave by ComFocus, Tone-Tag, Word Guess, and the 
SoftWave logo are trademarks of ComFocus Corporation. 
 
Microsoft and Windows are registered trademarks of Microsoft Corporation. 
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INTRODUCTION 
 
This manual is divided into two main sections.   Both sections are easy to read and 
provide valuable information for the most efficient use of SoftWave.  It is not 
necessary to read the entire manual prior to installation and operation of your 
receiver.  However it is very important to read GETTING STARTED and follow the 
installation instructions carefully. 
 
 
The two main sections of this manual, and a brief description of their contents is as 
follows: 
 
GETTING STARTED.   This section provides an inventory list of what you should 
have received and a list of system requirements and specific instructions for proper 
installation of SoftWave. 
 
 
OPERATIONAL INSTRUCTIONS.  This section outlines specific instructions for the 
operation of SoftWave.  It is purposefully written so that a novice user can take full 
advantage of the capabilities of SoftWave.  
 
 

CAUTION:  The cable from SoftWave’s DSP card 
must only be connected to the SoftWave external 
receiver module.  This cable provides the power 
to the receiver.  Serious damage could occur if 
this cable is connected to devices other than 
SoftWave. 
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HOW TO CONTACT COMFOCUS 
 
Before beginning installation of SoftWave please fill out and return the registration 
card.  This will allow us to serve you better when you call.  By becoming a registered 
SoftWave user you will automatically be qualified for early releases and discounts on 
future upgrades. 
 
If you are having difficulties installing the SoftWave DSP board, the Receiver unit, or 
the software, or if you have questions regarding the safe installation and use of 
SoftWave, please call our toll-free service line.  Before calling the ComFocus service 
department, try to find the answer to the problem in this manual.  If you cannot find a 
satisfactory answer in this manual and still need assistance, we encourage you to 
call.  Be prepared to provide the following information: 
 
• Your SoftWave Registration Number (on the bottom of the Receiver unit). 
• The type of computer you are using:  386 / 386SX / 486, brand name, etc.... 
• Other peripheral devices connected to your computer:  sound card, etc.... 
• Other electronic devices, (receivers, printers, TV’s, etc.) located near your 

computer. 
• The exact wording or error message which may have appeared on your screen. 
• A description of what happened and what you were doing when the problem 

occurred. 
• How you tried to correct the problem. 
 
 COMFOCUS SERVICE:  1-800 763-2750 
 
If you would like to purchase another SoftWave version 1.0 package from ComFocus 
or would like to know the location of the nearest dealer, call our toll-free sales line: 
 
 COMFOCUS SALES:  1-800-763-8983 
 
If you would like to contact ComFocus regarding other matters, please call our 
business office at: 
 
 COMFOCUS OFFICES:  (619) 455-9934 (619) 455-1259 (FAX) 
 
Direct all written correspondence to ComFocus at: 
 

ComFocus Corporation 
6160 Lusk Blvd.,  C-200 
San Diego, CA  92121 



SoftWave User’s Guide  3 

 

WARRANTY 
SoftWave hardware and software carry a warranty against defects in materials and 
workmanship for a period of one year from the date of purchase by the original user.  
During this warranty period, ComFocus will, at its option, either repair or replace 
components or products which prove to be defective. 
 
Should ComFocus be unable to repair or replace SoftWave within a reasonable 
amount of time, a refund of the purchase price may be given upon the return of 
SoftWave to ComFocus.  A Returned Merchandise Authorization number must be 
obtained from ComFocus prior to the return of any merchandise. 
 
 
Exclusions 
 
The warranty on SoftWave does not apply to defects resulting from: 
 

• Unauthorized modification or misuse. 
• Removal of the front or back panels of the SoftWave receiver. 
• Unauthorized integration with software manufactured by 

companies other than ComFocus Corporation. 
• Use with cables other than the cable provided by ComFocus. 
• Return of SoftWave in packaging other than the original 

packaging materials. 
 
 
The warranty period begins on the date of customer purchase.  If SoftWave fails 
during the warranty period contact the ComFocus service department at 1-800-763-
2750. 
 
If you do not have your original SoftWave packaging materials, call the ComFocus 
service department at 1-800-763-2750.  Additional packaging materials will be sent 
to you for a nominal charge. 
 
Limitations 
 
The warranty set forth above is exclusive and no other warranty, whether written or 
oral, is expressed or implied.  ComFocus specifically disclaims any implied 
warranties of merchantability and fitness for a particular purpose. 
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GETTING STARTED 
 
Before you begin to use SoftWave, please read the following sections.  These will 
help familiarize you with the items included in the product, the necessary 
requirements for your personal computer, and the most efficient method for system 
installation. 
 
 

What You Received 
 
SoftWave Version 1.0 includes the following items: 
 

• PC circuit card, also called the DSP board or simply DSP 
 

• External Receiver unit (small aluminum chassis approx. 3.0 x 7.0 x 9.0 in.) 
 

• Computer cable, 25 wire, 1 female, 1 male connector    
 NOTE: Electrical power is provided to the external 

radio through this cable.  Only this cable should 
be used with SoftWave.  Do not connect this cable 
to any other computer device. 
 

• Registration Card 
 

• SoftWave Technical Manual (this book) 
 

• Floppy disk pack  3.5 inch disks (2) 
 
 
All of the electronics have been carefully prepared at ComFocus and should reach 
you in excellent working condition.  We calibrate and “burn-in” each unit to confirm 
that all systems are working before we ship. 
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System Requirements 
 
 
Installation of SoftWave requires the installation of the PC circuit card inside your 
computer and the loading of the software on your computer. 
 
Recommended and required system configuration information follows in Table I: 
 

 
 
SoftWave has been designed to properly function with MS-DOS 3.2 and higher.  MS-
DOS 5.0 or higher is recommended. 
 
Unlike many add-on PC boards, the SoftWave DSP board does not use interrupts, 
DMA channels, or the high memory area.  This was purposely done to minimize 
conflict with other installed hardware.  SoftWave does use memory mapped 
input/output with a base address of 0x300.  The base address is switch selectable on 
the DSP board.  You must contact ComFocus for instructions on changing this 
setting. 
 
SoftWave has been designed to properly function with Microsoft Windows version 
3.1 and higher. 

 
Hardware/Software 

 
Recommended 

 
Minimum 

 
DOS 5.0 3.2 
Microsoft Windows 3.1 3.1 
Processor 486 286 
Coprocessor Built-in, else 387 highly 

recommended 
287 

RAM 4 Megabytes 4 Megabytes 
Disk Cache 500 kbyte min. None required 
Graphics Super VGA 1024x768 VGA 
Mouse Required Required 
Hard Disk Space 
Required 

6 Mb 6 Mb 

Expansion Slots 1 1 
Power Supply From your PC From your PC 
Antenna Better antenna will 

improve station reception. 
Std 50 ohm BNC female 

connector 

Whip antenna  

Table I. Minimum System Configuration Guidelines 
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Recommended Computer Resources 
 
SoftWave will operate on personal computers which use at least an Intel 286 
microprocessor.  Operation on 386 machines and particularly the 486 is encouraged.  
The built in spectrum analyzer function will operate much faster if a coprocessor is 
resident. 
 
Because SoftWave performs most of its processing on its own DSP, the speed 
of your processor does not affect the performance of the radio.  A slower PC 
will only affect the screen update rate for the spectrum analyzer, wideband spectrum 
analyzer, oscilloscope, and signal constellation. 
 
Most systems sold in the last few years are based on the Intel 486 microprocessor 
and come with MS-DOS 5.0 or 6.0 and Windows 3.1 pre-installed.  These systems 
are ideal for SoftWave 
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INSTALLATION 
 

Before you begin installation 
1. Read this entire chapter. 

2. Have the manual on your personal computer available for 
reference.  Review the chapter or section on removing the cover 
from your PC and installing an add-in card. 

3. Unplug all power sources to your PC now so your PC’s power 
supply will have time to discharge any risidual charge. 

 
 
DSP Board 

 
Please take your time installing the DSP board in your computer.  The procedure is 
fairly simple, however it is possible to cause injury to yourself or damage to your 
computer if you are not careful.  If you follow the steps given below, the card should 
be installed in about 15 minutes. 
 
1. Turn off the power to the computer and remove the power cord from the 
back panel.  It is important to keep the power cord disconnected at all times during 
installation of the DSP board.  If the power has been just turned off, residual charge 
will be present in the computer power supply.  Therefore, to minimize any risk, it is 
recommended that the computer power remain off for at least 15 minutes prior to 
installation. 
 
2. Remove the screws holding the cover on the computer.  There are usually 
four, sometimes five or six, on the back and along the edge.  It should not be 
necessary to remove all the screws on the back of the computer, just the screws that 
are used to secure the cover. Some computers have additional screws on the back 
cover - these hold the PC’s power supply in place.  Gently slide the cover off the 
computer. 
 
3. Notice that several circuit boards or "cards" are nested in slots and 
connected to the back of the computer.  Locate an empty full size slot with plenty of 
room around it for the installation of the DSP.  Remove the one screw and cover 
plate at the back of the computer which corresponds to the slot.  Save the screw, it 
will be needed for the DSP board.  You should now have enough room to completely 
install the DSP board.  Ideally, install the DSP board in a slot that is the farthest from 
the video board. 
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Step 1:  Turn off the power and remove 
the power cords.

Step 2:  Remove only the
screws on the 

perimeter of the cover.

Step 3:  Remove the cover plate on one of 
the slots on the back of the PC.

Slide the cover off carefully.

 
 
4. Slide the DSP board into the slot.  Make sure that the electrical contacts on 
the edge of the DSP board line up with the contacts in the slot.  Slowly and firmly 
push the DSP board into place. 
 
5. Replace the screw taken out with the cover plate.  The DSP card should now 
be tightly secured inside the computer.  For best grounding results this screw should 
be replaced tightly.  Otherwise excessive electromagnetic interference (EMI) may 
result which could impair your signal reception.  Make sure that there are no open 
slots on the back of the computer. 
 
6. Replace the cover on the computer.  Tighten each of the screws to secure 
the cover. 
 
7. Do not install the power cord to the computer just yet.  Wait until the receiver 
is installed. 
 
You are now ready to install the receiver. 
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Receiver Installation 
 
Before installing the receiver make sure that the power cord is still disconnected from 
the back of the computer. 
 
1. Choose a spot to place the receiver.  It can be located next to your monitor or 

computer, or even under a desk.  It is not necessary to place the receiver in the 
line of sight of the operator. 

 
2. Connect the SoftWave receiver cable to the back of the receiver.  Do not 

connect this cable to any device other than SoftWave’s receiver.  Serious 
damage could occur to other devices if they are connected to SoftWave’s 
DSP card. 

 
3. Connect the other end of the cable to the RS-232 connector on the DSP board, 

which should now be visible at the back of the computer.  Secure both ends of 
the cable tightly.  The DSP board will be distinguishable from other boards by the 
row of jack-type connectors on it. 

 
4. Reattach the power cord to the computer. 
 
 

Connecting the Speaker to the DSP Board 
 
The SoftWave DSP Board has 5 connectors which are accessible at the back of the 
PC.  Beginning at the top, the connectors are as follows: 
 
Connector # 1:  Control  3/32" (2.5mm)  
Connector # 2:  Speaker Out.  1/8"  (3.5mm) 
Connector # 3:  Line Out  1/8"  (3.5mm) 
Connector # 4:  Line In / Microphone In  1/8" (3.5mm) 
Connector # 5:  SoftWave Receiver ONLY 
 
Connectors 1 through 4 are designed for a standard banana plug.  Connector # 5 is 
designed for the special RS-232 cable provided with SoftWave. 
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Connect the speaker to Connector # 2, the second from the top, as shown above.   
 
Sit back and get comfortable, the hard part is over.  You are now ready to install the 
software. 
 
 

Software 
 
To load the SoftWave software: 
 
1. Turn on the computer.  Many computers begin with Windows immediately.  If 

yours does not, start Windows by typing WIN after the prompt  (C>WIN).  
Windows begins with "Program Manager". 
 

2. Use the mouse to point to the word FILE and click it once.  Your screen should 
look like this: 

 
 

 
 
 
3. Point the mouse to the word RUN and click it once.  A "command box" appears 

and the cursor is blinking on the line.   
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4. Insert Disk 1 into the disk drive on the computer. 

 
5. At the command box type either A:\SETUP  or  B:\SETUP ,  depending upon the 

drive containing the SoftWave setup disk. 
 

6. Follow the directions on the screen to complete the installation process. 
 
 

HOW TO TURN THE RECEIVER ON 
 
Before SoftWave will operate, all components must be installed correctly.  Please 
refer to the installation instructions in the "Getting Started" section for detailed 
information on installation.  Once the installation is complete you can start SoftWave. 
 
1. Turn on the computer.   

 
2. Enter Windows.  Many computers start directly with Windows.  If your computer 

begins with DOS, you will see C>.  Type   WIN   and press Enter.  The Windows 
program will begin and stop at the Program Manager screen.  The top "menu 
bar" looks like this: 

 
3. The Program Manager screen shows "icons" for each of the individual Windows 

programs.  Find the SoftWave "icon", use the mouse to point the arrow to it and 
double click. 
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At  the top of this entry screen is a menu bar with the following selections:   
 
File   Options   Personalities   Decode   Window   Help 
 
Hold the left mouse button down and move  the arrow across the menu bar.  You will 
notice a variety of choices under each item.  SoftWave includes six separate receiver 
products called "Personalities".  To begin SoftWave you first need to select one of 
the "Personalities".   
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HOW TO TURN THE RECEIVER OFF 
 
You can exit SoftWave several ways.  You can exit SoftWave the same way you exit 
Windows: 
 
1. Click the minus sign (“close box”) in the top left corner of the screen. 
 
2. Click "Close" to exit SoftWave and return to the Windows Program Manager 

screen.   
 
 

 
 
 

Exit and Stay Tuned 
 
You can exit SoftWave by selecting one of two choices on the "File" menu.  If you 
select “Exit and Stay Tuned” the SoftWave receiver will continue to operate after 
Softwave unloads.  At this point you can work with other Windows applications such 
as spreadsheets or word processors.  Please note that you do not have to exit 
SoftWave to use other programs.  You can simply “minimize” SoftWave (by clicking 
the down-arrow in the upper right corner) or leave it in the background.  SoftWave is 
fully Windows compliant. 
 
Using Exit and Stay Tuned, you can work on the computer and listen to SoftWave at 
the same time.  Since SoftWave uses the DSP board for most of the computations, 
the processing power of the computer is free for other applications. 
 

Exit and Shutdown 
 

If you select “Exit and Shutdown”, SoftWave will turn off the receiver and return to 
the Program Manager screen.   
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Save Setup 
 
Perhaps you want to listen to the same station at the same time each day (or at 
different times) and don’t want to go to the trouble of changing each of the receiver 
settings every time you turn on the receiver.  With SoftWave you can save individual 
receiver settings for your favorite programming. 
 
For example, say you like to listen to the BBC News in the morning.  Start at the 
Communications Radio and tune to the desired frequency.  (You can use Select 
Stations on the Option menu to choose the best frequency).  Optimize the filter 
setting, the AGC, Volume, High and Low Filters and other controls.  Now that the 
settings are exactly the way you want, you can use Save Setup to store the settings 
for future use. 
 
To save the current settings: 
 
1. Select File from the top menu bar. 
2. Select "Save Setup".  The window shown below will appear. 
3. Type a description for the current setting.  You may enter up to 40 characters. 
4. Click "Save" to save the named setting. 
 
Softwave can save up to 5 sets of settings.  If you click the “Position” button on the 
Save Setup dialog you can decide which one of the five “slots” you want to save in.  
Or you can let SoftWave decide for you. 
 
You can also click the “Restore these settings at startup” checkbox if you want the 
current settings to be restored whenever you start SoftWave. 
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OPERATION INSTRUCTIONS 
 

PERSONALITIES 
 
SoftWave, version 1.0 includes six different radio products or "personalities".  Each 
has different characteristics.  Some features are unique to one personality while 
other features are common to several.  For example, SoftWave takes some of the 
best features of a top of the line shortwave receiver and implements them on the 
VHF Receiver.   
 
Depending on the extent of your knowledge and interest in wireless communications, 
you will probably use the Communications Radio or VHF Radio first.  However, to 
begin the discussion of personalities, we will start with the AM Radio. 
 
 
THE AM RADIO 
To start the AM Radio: 
 
1.  Pull down the Personalities menu. 
 

 
 
 
2.  Select the AM Radio by clicking with the left mouse button on the words AM 

Radio.  The AM Radio will appear. 
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For information regarding the Audio settings and the AM or AM-Syn demodulators, 
see the Communications Radio section of this manual. 
 

Tuning the AM Radio 
 
There are five different methods of tuning the AM Radio 
 
• Click the mouse in the AM-band Display 
• Type the frequency 
• Click a station preset (or use Alt + 1 to Alt + 8 to select a preset) 
• Use the AM Database 
• Use the frequency scroll bar 
 
 
AM-Band Display 
 
The AM-Band Display is that part of the AM Radio which looks like your old car radio.  
You can tune the radio by clicking the left mouse button in this display panel.  This is 
especially helpful for quick changes. 
 
Type the Frequency 
 
You can type the frequency using the 10-key keypad or regular numbers on your 
keyboard.  The frequency can be entered with the cursor in any location on the 
screen.   The cursor does not need to be in the digital frequency display.   
 
If your cursor is not in the frequency display, then when you begin typing a frequency, 
the cursor will jump to the left-most position in the display (ie. the 100 Mhz spot).  
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Note that the frequency display will attempt to keep your typed frequency within the 
535 to 1610 AM band. 
 
Station Presets 
 
SoftWave’s AM Radio personality comes with 8 station preset buttons.  To use a 
preset, simply click on it or press Alt + 1 through Alt + 8 (press and hold the “Alt” key 
while pressing a number 1 to 8 above the keyboard, not on the keypad). 
 
To set the station presets: 
 
1. Tune the radio to the desired frequency. 
 
2. Click the “Set” button 
 
3. Click the preset button you wish to set. 
 
Note that when SoftWave ships, the presets are set to “?”.  The question mark will 

disappear as soon as you set the preset. 
 
 
The AM Database 
 
SoftWave's AM Radio includes a database of all broadcast AM Radio Stations in the 
United States, Canada, Mexico, Cuba and the Caribbean.  Over 5000 stations are 
included.  The database is normally not shown.  You can show the database by 
clicking the “Database >>“ button (or pressing Alt+D which is the hotkey for that 
button).  The AM screen will expand to show the entire AM database in frequency 
and station order. 
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THE COMMUNICATIONS RADIO 
 
To start the Communications Radio: 

 
1. Pull down the Personalities menu. 
 

 
 
2. Select "Communications Radio".  The entry screen will be replaced by the 

Communications Radio.   
 
The Communications Radio will fill the screen at a resolution of 640 x 480.  This 
radio will also operate at other screen resolutions such as 800 x 600 or 1024 x 768.  
The higher resolution may be desired if you want to overlay SoftWave on another 
screen.  For a more detailed description of using different screen resolutions or 
combining several Windows programs on the same screen, refer to your Windows 
manual. 
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Tuning the Receiver 
 
There are four methods of tuning the Communications Receiver: 
 

• Type the frequency 
• Use the scroll bar 
• Use the “Select Stations” dialog on the Options menu 
• Click on the Spectrum Analyzer. 

 
Type the Frequency 
 
The easiest method of tuning the receiver is simply to enter the desired frequency 
using the 10 key keypad on your keyboard.  It is not necessary to type with the cursor 
in the frequency display.  You can type the desired frequency with the cursor in any 
position on the screen.  As you begin typing, the cursor will jump into the frequency 
display at the left-most position. 
 
Please note that the backspace key does not work in the frequency display.  Use the 
left arrow, right arrow, home, and end keys to move the cursor within the display. 
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Use the Scroll bar 
 
 

 
 
 
 
 
 
 
 
The receiver can also be tuned using the scroll bar under the frequency display.  
This scroll bar can be moved three ways: 
 
1. Point the mouse to the button shown in the center of the scroll bar above -- 

the scroll “thumb.”  Click the left mouse button and hold it down.  While 
holding the button down, move the mouse left or right.  As you hold the scroll 
thumb out, the frequency will continue to change.  The size of the change is 
variable.  The greater the distance from center the thumb is moved, the 
greater the rate of frequency change.  So, for example, if you hold the scroll 
thumb slightly off center your frequency will change by 10 Hz.  A little further 
and it will change by 100 Hz, 1 kHz, 10 kHz, etc....  Note that if this scrolling 
is too fast for your taste, you can change the rate of tuning on the 
“Miscellaneous Options” dialog found on the “Options” menu. 

 
2. Point and click on one of the arrows at the end of the scroll bar.  The 

frequency will change in 10 Hz steps. 
 
3. Point and click on the scroll bar itself between the scroll thumb and the 

arrow.  The frequency will change in increments 1 kHz. 
 
 
Use the “Select Stations” dialog on the Options menu. 
 
The third method of tuning the Communications Radio is by using the Select Stations 
Option.  This option allows the user access to SoftWave's database of world wide 
shortwave programming.  To select a station from the database, click OPTIONS at 
the top menu bar.  A drop down menu will appear.  Choose SELECT STATION to 
open the database.  For detailed information on the use of the Select Station Option, 
please refer to the section on Options, later in this manual. 

Point into the frequency 
display and click.  Then 
type the desired frequency. 

Click the arrow for fine tuning. 

Click the scroll bar for quick 
changes. 

Click and hold.  Then 
slide left or right. 
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Click on the Spectrum Analyzer 
 
The fourth method of tuning the Communications Radio is by clicking directly on the 
spectrum analyzer.  The radio will automatically tune to the frequency you clicked on.  
This is especially helpful for fine-tuning.  Just click on the signal carrier and 
SoftWave will center it for you. 
 
 

Demodulators 
 
SoftWave has seven different demodulators which provide the user a variety of 
listening options. 
 
The demodulator selection can be changed by using the mouse to point and click on 
the desired demodulator.  The presently selected demodulator is displayed in the box 
at the top of the columns.  
 

    
 
Each of the demodulators have specific characteristics and default settings.  When 
you change demods, SoftWave will automatically configure the other radio controls 
to the standard settings for the new demod.  For example, when you select LSB or 
USB, SoftWave automatically engages the Notch over the signal carrier. 
 
AM: Standard AM envelope detector. 
 
AM-Syn (AM Synchronous):  Synchronous detection is a superior means for 

detecting very weak AM stations which would otherwise be garbled using the 
AM detector. 

 
CW:  A transparent mode which is unlike any found on normal radios.  Helpful for 

finding general unknown signals.  In CW mode, the Hi and Lo filter scroll 
bars are disabled. 

 
CW-NB (CW - Narrow Band):  Sophisticated narrow band Morse code mode with 

adjustable bandwidths from 690 Hz down to 49 Hz.  The frequency of any 

The current demodulator 
selection is shown here. 
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audible CW signal may be changed by adjusting the beat frequency 
oscillator (BFO) scroll bar. In CW-NB mode, the Hi and Lo filter scroll bars 
are disabled. 

 
CW-TT (CW - Tone Tag):  SoftWave’s automatic Morse decoding capabilities make 

it possible to listen to a highly processed version of the CW signal.  This 
processing automatically tracks the incoming signal frequency and detects 
whether or not dots and dashes are present.  When a signal is detected by 
the processing, a perfect noise free audio tone is output over the speaker.  
Regardless of signal fading, noise, or slight frequency changes, the output 
quality remains constant so long as the received signal exhibits a minimum 
required signal strength. In CW-TT mode, the Hi and Lo filter scroll bars are 
disabled.  Like CW-NB, the pitch of the audible tone may be changed using 
the BFO scroll bar. 

 
FM-PLL:  The standard SoftWave FM demodulator is based upon coherent 

processing using a phase-locked loop.  This approach delivers superior 
audio fidelity and linearity.  In FM-PLL mode, the IF filter width is locked at 11 
kHz and the IF Shift scroll bar is disabled. 

 
FM-XP:  The cross product FM demodulator is recommended for use under severely 

poor signal-to-noise ratio conditions where the level of impulse noise is 
unacceptable to the FM-PLL demodulator. 

 
LSB (Lower Side Band):  Signal processing techniques are used to realize very 

sharp sideband filtering and demodulation.  The notch filter is automatically 
engaged in this mode to heighten carrier rejection.  This mode can also be 
used for AM reception under poor signal conditions.  In LSB mode, the IF 
filter width is limited to 5.5 kHz maximum. 

 
USB (Upper Side Band):  Same as LSB, but the upper rather than the lower 

sideband is demodulated. 
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Audio 
 
The audio section of the Communications Radio gives the user control of the 
Volume, High Filter (treble) and Low Filter (bass) functions.  The scroll bars can be 
adjusted vary the audio tone controls over a wide range.  Cut & boost range for the 
bass and treble portions both span ± 15 dB.  When either the Hi or Lo filter scroll 
bars are centered, the filtering is effectively turned off.  To center one of these scroll 
bars, move the scroll thumb all the way over to the left then click on the scroll bar 
between the thumb and the arrow until the thumb looks centered.  You should hear 
the filter turn off when you hit center. 
 
 

Click and hold here.  Slide the
button right or left to adjust the
volume.

Click here for small changes.
 

 
 
 

Squelch 
 
The squelch control is used primarily with FM communications to disable the audio 
output during time intervals when the signal is extremely weak or absent.   
 

 
 
The Level control is calibrated in minus dBm -- which corresponds directly to the 
signal strength indicator at the top of the frequency display (see “Tuning the 
Receiver” above).  When the scroll thumb is on the left side, it is at -130 dBm.  
Clicking on the scroll arrow will change the setting by 1 dBm.  Clicking on the scroll 
bar beside the thumb will move it by 10 dBm. 
 
For example, to squelch a signal that has a -110 dBm noise floor, move the Squelch 
Level scroll all the way to the left.  Then click on the scroll bar (not the arrows), two 
(2) times.  This will move the squelch level from -130 to -110.  Then use the right 
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arrow on the scroll bar to pull the squelch level up two or three times to set it around 
-108 or -107. 
 
 
 

Blanker 
 
The blanker function is normally used with AM and LSB/USB modes to mitigate 
severe impulsive noise like that from a car alternator, electric vacuum cleaner, etc.  
The blanker function uses a dynamic threshold computed within the DSP.  The 
threshold may be varied with the “Level” scroll bar. 
 

 
 
The anticipate control allows each blanking interval to be initiated before any portion 
of a noise impulse actually reaches the speaker.  The hold function can be used to 
extend the blanking interval as desired beyond the disappearance of any noise 
impulse. 
 
 
 

RF Attenuator and RF Gain 
 

 
 
The RF Attenuator attenuates the entire signal -- noise and carrier alike.  The 
attenuator is automatically engaged by SoftWave whenever the signal strength goes 
over -35 dBm. 
 
The RF gain control makes it possible to limit the maximum receiver gain which the 
radio will use.  This feature is primarily for those who wish to receive strong signals 
only.  Normally the Gain should be set to the left-most position. 
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Narrowband Spectrum Analyzer 
 

The filter bandwidth is 
displayed in yellow.

The received signal is 
displayed in red.

  
SoftWave is the first computer-based digital receiver featuring a spectrum 
analyzer.  The spectrum analyzer shows the received signal spectrum in 
"real time".  This means that here is very little delay between what is heard 
and what is shown on the screen.  The user can see not only the desired 
signal, but also any unwanted signals or "noise" which may be close to the 
received signal.  The spectrum display makes it easy to use the notch filter 
to eliminate any strong nearby sinusoidal carrier, or to adjust the receiver 
filtering to mitigate severe noise occurring in parts of the received spectrum  
The spectrum display can be zoomed in or out using the scroll bar below the 
display.  The spectrum span can be varied from +/-10 kHz to +/-200 Hz. 
 
Depending upon your PC monitor and your antenna configuration, you may 
hear a rhythmic click in the audio output that coincides with a new spectrum 
sweep.  This indicates poor or improper shielding of your antenna.  It is 
picking up a broadband EMI burst from your PC monitor and relaying it to 
SoftWave as a noise burst.  If you are unable to properly shield your antenna 
from this, you can adjust the rate of the spectrum update on the 
“Miscellaneous Options” dialog box on the Options menu.  Slowing the plot 
speed down will slow the click sound.  You can even turn off the spectrum 
completely from that dialog box. 
 
 
 

Oscilloscope and Signal Constellation 
 
The pulldown list below the narrowband spectrum analyzer also allows you to switch 
the screen into Oscilloscope or Signal Constellation mode. 
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IF Filter 
 

The current filter setting
is displayed below the 
slider.

 
 
The IF (Intermediate Frequency) Filter can be adjusted to improve listening.  The 
filter is overlaid on the narrowband spectrum analyzer in yellow.  The filter 
characteristic is replotted for any changes made from the comm radio. 
 
The Shift scroll bar allows you to shift the IF Filter within the spectrum analyzer -- 
effectively receiving a different portion of the displayed signal. 
 
There are several benefits of simultaneously showing the filter and the received 
signal on the spectrum analyzer.  For example, the filter can be set in a wide position 
and used to search for possible stations.  Once the presence of a signal has been 
identified the filter can be narrowed to remove any extra signals or noise off to the 
sides of the center signal.  In areas with a large amount of broadcast activity, the 
filter can be used to select one station while eliminating others.   
 
SoftWave has the following 48 filter bandwidths: 
 
11.00 kHz 
9.810 kHz 
8.750 kHz 
7.800 kHz 
6.960 kHz 
6.200 kHz 
5.530 kHz 
4.900 kHz 
4.400 kHz 
3.900 kHz 
3.480 kHz 
3.100 kHz 
2.770 kHz 
2.470 kHz 
2.200 kHz 
1.950 kHz 

1.740 kHz 
1.550 kHz 
1.380 kHz 
1.230 kHz 
1.100 kHz 
970 Hz 
870 Hz 
780 Hz 
690 Hz 
620 Hz 
550 Hz 
488 Hz 
430 Hz 
380 Hz 
346 Hz 
308 Hz 

275 Hz 
244 Hz 
217 Hz 
194 Hz 
173 Hz 
154 Hz 
137 Hz 
122 Hz 
109 Hz 
97 Hz 
87 Hz 
77 Hz 
69 Hz 
61 Hz 
55 Hz 
49 Hz 
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Notch 
 

Click here to engage the notch.
Use the sliders to adjust for 
optimum listening conditions.

 
 
The Notch filter can be adjusted in the same manner as the IF Filter.  Point the arrow 
to the button and click once to turn the notch "on".  You can now use the scroll bars 
to vary the width, shift and depth.  Unwanted signal interference can be notched out 
for improved listening results.  Notch is primarily intended for CW and U/LSB but can 
be used for any of the demods. 
 
 

AGC 
 

 
 
Received signal strength can vary dramatically over a short period of time, thus 
automatic gain control (AGC) is required to keep the audio output reasonably 
constant.  This function can be engaged using the AGC on/off button.  
 
The Attack scroll bar changes the speed at which the radio increases its gain.  
Similarly, the Decay scroll bar governs how quickly the receiver reduces its gain.   
 
The Hold scroll bar delays the AGC Attack.  This is particularly useful with Morse 
code signals where the presence and absence of the carrier is used to indicate the 
dots and dashes.  A quick attack time on the AGC would cause the receiver itself to 
interfere with the signal by dramatically increasing the signal gain in every space.  
Hold allows for smooth reception. 
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VFO 
 

 
 
If two frequencies are being used back and forth, like monitoring split channel 
operation, two different frequency settings can be maintained by using VFO A and 
VFO B.  The VFOs store only the frequency, not the radio settings. 
 
 
 

BFO 
 

 
 
The beat frequency oscillator function is only used by SoftWave during CW-NB and 
CW-TT operation.  This control determines the pitch of the frequency heard in these 
modes. 
 
 
 

Calibrate 
 

Using digital signal processing and the power of the personal computer, SoftWave 
can calibrate the receiver to frequency accuracy less than 1 part per million (1 PPM).  
When a receiver is accurate to one part per million the tuning error will be off no 
more than 1 Hz when receiving 1 MHz. 
 
To calibrate your SoftWave receiver: 
 
Wait for the receiver to warm up.  Complete warm-up normally requires 
approximately 30 minutes. 
 
1. Tune the receiver to a designated calibration frequency.  For best results the 

calibration frequency should be a strong station in the VHF band (above 108 
MHz).  In most areas of the continental United States, NOAA broadcasts at 
around 162 MHz (in some areas it is 162.4 MHz).  The calibration frequency 
could also be an accurate frequency standard such as WWV at 5, 10, 15 or 20 
MHz.  Note:  SoftWave frequency calibration can be no more accurate than the 
actual precision of the calibration station frequency used.  If the station is 
broadcasting 50 Hz off frequency, you will calibrate 50 Hz off. 
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2. Click the Calibrate button on the Communications Radio         The 
following window will appear. 

 

 
 
3. Click the calibrate button on the Radio Calibration window. 
 
Calibration settings are automatically saved from one session to the next, making 
frequent calibration unnecessary after the initial time. 
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THE VHF RADIO 
 
SoftWave includes a high performance VHF Radio with continuous coverage from 
108 MHz to 174 MHz.  To start the VHF Radio 
 
1. Pull down the Personalities menu. 
 

 
 
2. Select the VHF Radio by clicking on the words "VHF Radio". 
 
The VHF Radio will appear on the screen.  The controls and frequency display will 
not fill the entire monitor screen.  The radio can be "dragged" to a convenient 
location on the screen.  You can also use the “Cascade” or “Tile” options on the 
“Window” menu to arrange windows on the screen. 
 

 
 
The Audio, RF, Squelch, and Demodulator controls on the VHF Radio operate in the 
same manner described for the Communications Radio.  Additionally, the VHF radio 
contains controls specific to SoftWave’s VHF scanning capabilities.  These are 
described in the following sections. 
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Assign Split 
 
SoftWave allows you to monitor two frequencies without going into Scanning mode.  
To do so, type the first frequency in and press the “Assign Split” button.  This 
frequency is now pushed into the “Split hold” area in the top right of the frequency 
display.  Type in the second frequency. 
 
SoftWave will stay on the current frequency until signal loss (determined by the 
Squelch level scroll bar).  Once signal loss has occured, SoftWave will begin 
checking the secondary channel 2x per second.  If a signal appears on either 
channel, SoftWave will make that the main channel and stop monitoring the 
secondary until signal loss occurs again. 
 
The “Assign Split” button will change to “Clear Split” once a split is assigned.  To 
cancel split monitoring, press the “Clear Split” button. 
 
 
 

Scan & Stop 
 
The “Scan” button loads the hilighted scanning group and begins scanning.  When 
scanning starts, several changes occur to the VHF screen.  
  

The Squelch is turned on and cannot be turned off.  The squelch level is 
used by SoftWave to determine “signal loss”.  This is important if the 
“Dwell until Signal Loss” option is checked.  Once a signal is 
squelched, SoftWave starts the Dwell time countdown (see below).  
If the signal remains squelched for the whole dwell time then 
SoftWave automatically continues scanning. 

The “Scan” button becomes the “Stop” button.  Press this button to stop 
scanning. Scanning will automatically stop whenever you leave the 
VHF radio or pull up a dialog box from the menu. 

The “Lockout” button is disabled.  Lockout will automatically enable 
whenever scanning is stopped by signal detection or by the Stop 
button. 

The Frequency display clears and whenever a frequency appears it is light 
blue rather than green.  This indicates you are in scan mode.  During 
scan mode you cannot change the frequency. 
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Lockout 
 
Lockout allows you to keep SoftWave from ever scanning certain frequencies.  For 
example, suppose you are scanning and SoftWave continually stops at a data carrier 
in your scanning range.  You can lockout this frequency from future access by the 
receiver.  By clicking Lockout, the frequency is added to the “Lockout” scanning 
group.  If there is no “Lockout” group in your Scanning Groups list, SoftWave will 
create one.  Every time you direct SoftWave to scan a group, the frequencies in the 
Lockout group will be skipped. 
 
The Lockout group can be edited, added to, or deleted just like any other group.  You 
can even scan the Lockout group (SoftWave recognizes that it is the lockout group 
and won’t try to lockout all the frequencies in it).  Note as well that the Lockout group 
can contain over 128 channels.  When this occurs SoftWave will still operate 
normally but you will be unable to scan the Lockout group itself. 
 
When SoftWave locks out a frequency, it attempts to lockout the entire channel by 
creating a frequency range entry in the lockout group for the locked out frequency 
plus or minus half the IF filter width.  This means that even if you hit near a frequency 
you wish to lock out, Lockout will still lock it out. 
 
 
 

Detection Threshold 
 
This scroll bar works closely with the Squelch Level scroll in SoftWave’s scanning.  
The detection threshold is calibrated in minus dBm just like the Squelch Level.  See 
the Squelch Level section of the Comm Radio for an explanation of how to determine 
the level for this scroll. 
 
The Detection threshold and Squelch levels can never cross or be on the same 
number.  The Squelch level must always be below the detection threshold.  Thus, as 
you move the detection threshold down, the squelch level will move down as well.  
The opposite holds true when you move the squelch level up. 
 
The Detection threshold and Squelch level can be within one dBm of each other.  As 
soon as they are equal, SoftWave will push one of them off by 5 dBm.  It is 
recommended that you keep them about 10 dBm apart.  Typical settings are -80 for 
the Detection threshold (the scroll thumb will be centered in the scroll bar) and -100 
for the Squelch level. 
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Dwell until Signal Loss & Dwell Time 
 
SoftWave allows you to scan in two different ways.  You can do timed scanning or 
signal loss scanning.  This is controlled by the “Dwell until Signal Loss” check box.  If 
this option is checked, SoftWave will do Signal Loss scanning.  If the option is turned 
off, SoftWave will do Timed scanning. 
 
Timed Scanning 
 
In Timed scanning, the “Dwell Time after Loss” prompt changes to “Dwell Time”.  
This time then determines how long SoftWave should stay on a “hit” until continuing 
scanning, regardless of signal presence.  SoftWave ignores signal loss altogether. 
 
Signal Loss Scanning  
 
In Signal Loss scanning, the “Dwell Time after Loss” prompt determines how long 
SoftWave waits after signal loss before continuing scanning.  The length of time here 
allows for replies in conversations.  Typically a value of 3 or 4 seconds works best.  
Signal Loss is determined by the “Squelch Level” control.  Once a signal has been 
squelched for the dwell time, then SoftWave continues scanning.  Note that for Split 
channels, as soon as signal loss occurs (ie. the signal is squelched), SoftWave 
begins checking the secondary channel.  If signal appears on the secondary 
channel, SoftWave will automatically switch to it.  Scanning will not continue until 
both channels have been squelched for the dwell time. 
 
 
 

Scanning Groups 
 
SoftWave's VHF scanner will scan groups of up to 128 channels at a rate of 
approximately 200 channels per second.  The precise rate at which the receiver 
scans is dependent upon the distance between the frequencies selected.  If the 
scanning group is full (maximum 128 frequencies per scanning group) and the 
frequencies range from a low of 108 MHz to a high of 174 MHz, SoftWave's scan 
speed could slow down to as low as 100 stations per second. 
 
Because SoftWave is based in the PC, you can have as many scanning groups as 
you wish.  Each group can contain up to 128 frequencies.  The groups listed in the 
VHF screen-shot above are example groups shipped with the product.  If the list in 
the display fills up, a scroll bar will appear attached to the list. 
 

The  buttons below the list allow you to add or modify 
scanning groups.  “Add” will add a new group.  “Edit” will edit the currently hilighted 
group.  “Delete” will delete the currently hilighted group.  Add and Edit bring up the 
dialog below. 
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The Group Name may contain up to 40 characters, spaces, symbols, etc... and may 
not be blank. 
 
The frequency boxes and radio buttons in the center of the dialog are the entry area.  
This is where new frequencies are entered.  Type a frequency in the first box then 
select the appropriate radio button.  A frequency range may go in steps of 1 to 1000 
kHz.  Remember, however, that there may only be 128 channels in a group.  So, for 
example, attempting to create a range from 108 Mhz to 174 Mhz in steps of 1 kHz 
results in 66,000 channels - too many for SoftWave to handle. 
 
The list at the bottom of the dialog shows what frequencies, frequency ranges, and 
split frequencies have been placed in the group.  The example above contains one 
of each. The first item is a frequency range from 156 to 159 Mhz in steps of 50 kHz.  
This results in 61 channels (159 - 156 = 3 Mhz; 3 Mhz / 50 kHz = 60 channels; add 
one channel for 159 Mhz). 
 
The second item is a split frequency.  It counts as two channels.  If the VHF scanner 
stops on a split set, it will load the split frequency into the VHF display.  If the scanner 
is set to dwell until signal loss, it will dwell until there is signal loss on both channels 
in the split. The last item is a single channel, 161 Mhz. 
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WORLD RADIO 
 
To start the World Radio: 
 
1. Pull down the Personalities menu. 
 

 
 
2. Select the World Radio by clicking on the words "World Radio". 
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The World Radio is designed for the novice Shortwave Listener who may not be 
familiar with the controls on the Communications Radio.  This radio has only the 
essential controls to receive worldwide shortwave broadcasting.  By clicking on a 
particular country or continent, the user can zoom-in to a detailed map of the 
selected area.  At this point the user can select a station from the database of 
worldwide programming.  The database is automatically narrowed to include only 
stations in the selected area. 
 
To return to the global map (from a detailed map) click once on the globe in the 
lower right corner of the map, or click the right mouse button. 
 
For more information about the database, see the section of this manual on “Select 
Station”. 
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WIDE BAND SPECTRUM ANALYZER 
 
To start the Spectrum Analyzer: 
 
1. Pull down the Personalities menu. 
 

 
 
2. Select Spectrum Analyzer by clicking on the words Spectrum Analyzer. 
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SoftWave includes a Wideband Spectrum Analyzer which allows the user to search 
for band activity in a sweep of up to 5 MHz at a time.  This spectrum analyzer is 
useful in many ways.  For example you can look for activity on the entire 2 meter FM 
band in one sweep.  Note that this spectrum analyzer will work in both HF and VHF 
bands.  If you are curious about a certain signal, you can tune the SoftWave receiver 
by clicking directly on the signal in the spectrum analyzer. 
 

Span 
 
The spectrum analyzer is shown above with a span of 5 MHz.  The span is variable 
from 200 kHz to 5 MHz.  The Span scroll bar will change the span to 200, 400, 600, 
or 800 kHz, and 1 - 5 MHz. 
 
The spectrum analyzer displays signal amplitudes ranging from roughly -130 dBm to 
-50 dBm.  In this range, displayed level accuracy is typically better than 5 dB.  The 
user is nonetheless cautioned that this mode is intended for finding active stations 
rather than for precision signal power measurements. 
 

Frequency 
 
The frequency shown on the screen is the “center frequency” -- the frequency at the 
center of the plot.  To tune the spectrum analyzer, you can type in a new frequency, 
scroll the tuning scroll bar, or click on the spectrum itself.  The new frequency you 
select becomes the center frequency. 
 

Accumulate 
 
The accumulate option is most useful for finding weak carriers - such as morse 
code.  It normalizes the noise floor then begins, with each plot, to exagerate the 
signals received.  As the noise floor raises in the plot, any carriers buried in the noise 
floor will raise at a faster rate and, after 5 or 6 plots, will be easily identifiable. 
 

Max Hold 
 
Max Hold is most useful in the VHF band.  It holds the highest point seen across 
multiple plots.  So if a VHF carrier jumps onto the plot then goes away, the spectrum 
analyzer will still hold it there so you can accurately tune to it. 
 

Go to Comm, Go to VHF 
 
These buttons take you directly to the Comm or VHF radios.  You can also use the 
Personalities menu. 
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TIME SYNC RADIO 
 
To start the Time Sync Radio: 
 
1. Pull down the Personalities menu. 
 

 
 
2. Select the Time Sync by clicking once on the words "Time Sync". 
 

 
 
The Time Sync Radio automatically scans the six WWV frequencies.  A bar showing 
the relative quality and strength of each signal is shown.  SoftWave picks the signal 
with the best “Quality” (see Select Station for a description of quality) and tunes to 
that one.  Its signal strength indicator will update once per second.   
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To select a different WWV station, click on its frequency or strength graph.  You will 
hear the radio tune to the new frequency. 
 

Changing the Time 
 
The time, in UTC or local time, can only be changed by clicking on the up and down 
arrows (spinners) next to the numbers.  Click the mouse on the number you want to 
change (such as the minutes), then click on the appropriate spinner. 
 
Note that there are two forces at work here.  The current time (“Local Time”) and the 
Local / UTC time variance.  If you change the time shown in the “UTC Time” slot, the 
local time will also change.  If you want to keep the local time the same and just 
change the UTC time, change the Local / UTC time variance. 
 

Clear Seconds and Save 
 
To set your PC clock to the accurate time using WWV: 
 
1. Select the strongest signal on which WWV is transmitted.   
2. Select the wide or narrow filter and adjust the volume control to optimize listening 

conditions. 
3. When the tone is given on WWV to indicate the accurate time click "Clear 

Seconds". 
4. Click the "Save" button to set your PC clock. 
 
 

Calibrate 
 
For a full description of the calibration function, see “Calibration” in the Comm Radio 
section. 
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DECODE 
 
SoftWave has the ability to decode digital signals and display them on the computer 
screen.  Version 1 of SoftWave includes a Morse Code Decoder.  Later versions will 
include a multitude of additional capabilities. 
 
 
MORSE CODE TRANSLATOR 
 
To begin the Morse Code Translator, you must first start the Communication 
personality.  Next find a Morse code signal.  If you are having difficulty finding a 
Morse code signal, try using the Wideband Spectrum Analyzer with frequencies 
around 8.5 MHz, (8,500,000 kHz) -- the Accumulate option might be helpful there.  
On the Comm Radio, select CW or CW-NB.  (The CW-TT demodulator is most 
effective after a CW signal is identified).  After a Morse code signal is found, you can 
begin to use the Morse Code Translator. 
 
To start the Morse Code Translator: 
 
1. Pull down the “Decode” menu. 
 

 
 
2. Click Morse Code.  The Morse Code Translator window will appear.   
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3. To resize the morse code window, move the mouse to the bottom border of 

the Translator window.  When it is exactly on the border the single arrow will 
change to a double arrow.  Click and hold the double arrow and drag the 
border to the new size. 

 
4. To move the morse code window, click and hold the title bar (it contains the 

words "Morse Code Translator").  Drag the window to the bottom half of the 
screen or a location where you can quickly move from the radio to the 
translator.  (Note:  This is a circumstance where you may want to consider a 
screen resolution of 1024 x 768 or 800 x 600.  For additional information on 
different screen resolutions refer to chapter.........).   Typically, once you have 
zoomed in on a frequency on the Comm Radio everything else you’ll need to 
do can be done right from the Translator window. 

 
The Morse Code Translator will begin to display text shortly after the screen appears. 
 

Morse Code Menu 
 
When the morse code decoder is the active window it places its own menu pulldown 
on the menu bar.  This pulldown contains options to turn on or off the two PDFs, 
select the buffer size for translated characters, and select a log file. 
 
 

Word Guess 
 
There are certain rules of spelling in the English language which are never violated.  
Some rules have exceptions, but only under a few circumstances.  Additionally, 
some letters have a far higher probability of appearing in a word than others.  
SoftWave uses these principles as the basis for the Word Guess command. 
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For Example, there are no English words which have four consonants in a row.  
Therefore, by enabling Word Guess, SoftWave will look for a vowel after translating 
three consonants.  As another example, if the first letter in a word is "T", what is the 
probability that the next letter will be "H", or "E", or "B"? 
 
Word Guess has been optimized for unabbreviated English text and is most helpful 
under poor signal-to-noise conditions or when sender quality is poor. 
 
When Word Guess determines that a word needs correction the corrected word will 
appear in italics.   
 
 

ABBR Decode 
 
Most experienced senders of Morse code use abbreviations.  Words can be sent 
faster and more efficiently if commonly used words are abbreviated.  For example, 
the abbreviation "thx" is commonly used for "thanks".  SoftWave includes a library of 
these words, and their typical abbreviation.  When the ABBR Decode command is 
enabled and an abbreviation is decoded, SoftWave will look to the library, find the 
correct extension of the abbreviation and show both on the screen.  The extended 
word is shown in italics. 
 
 

QSIG Decode 
 
Another form of abbreviations used by experienced Morse code enthusiasts are Q 
signals.  Q signals are three letter abbreviations, which begin with the letter Q, and 
have a specific meaning.  For example, "QTH" is the abbreviation for location.  When 
SoftWave receives "QTH" it means that the sender is either asking "what is your 
location?"  or stating "my location is  ........". 
 
SoftWave includes a library of Q signals.  When the QSIG command is enabled and 
a three letter word beginning with "Q" is decoded, SoftWave will look to the library to 
determine if it is a Q signal.  If a Q signal is identified, SoftWave will show both the 
transmitted letters and the meaning.  
 
 

AFC Enable 
 
 
 

Words Per Minute 
 
SoftWave will keep track of the speed of the received signal.  It is assumed that a 
typical word is 5 characters long.  Therefore SoftWave will take into account the 
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transmission of both long and short words.  The number of words per minute is 
shown in the translation window. 
 
 

Sender Quality 
 
Using the values determined by the Dot / Dash probability distribution function, the 
Spacing probability distribution function, the character error rate and the speed, 
SoftWave can determine a value for the quality of the signal sent.  This value is 
shown next to words per minute. 
 
 

Character Error Rate 
 
Morse code signals transmitted by hand often include errors for a particular 
character.  Perhaps the character should have been transmitted with one more dot 
or dash.  SoftWave will identify this type of error and display a "character error rate".  
The Character Error Rate is shown in the box next to the Sender Quality. 
 
 

Log File 
 
To record the text decoded by the translator follow these steps: 
 
1. Pulldown the “MorseCode” menu and select “Log File...” 

 
2. Select an appropriate directory and type a file name.  If you do not specify a 

file extension, SoftWave will give it the extension .LOG.  When logging 
begins, the log file’s name will appear in the translator window. 

 
To Close a log file: 
 
1. Pulldown the “MorseCode” menu and select “Log File...” 

 
2. Select the “Cancel” button or press Escape. 
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BFO Pitch 
 
For a complete description of BFO, see the Comm Radio section. 
 
 

Bandwidth 
 
The Morse Code Translator allows you to vary the filter bandwidth from  690 Hz to 49 
Hz.  This can be done using the scroll bar.  As the scroll bar is adjusted, the filter 
bandwidth is shown on the indicator box.   
 
 

Zoom-In, Zoom-Out 
 
SoftWave allows the user to return to a previous narrow filter bandwidth very quickly 
by selecting the Zoom-In command.  When this command is selected the filter will be 
automatically reduced to the previous narrow setting.   
 
Zoom-In will only go in to as narrow a filter as you’ve previously been to on the morse 
code translator.  Zoom-Out will return you to 690 Hz. 
 
Note:  Unless the filter is centered exactly on the desired signal the Zoom In 
command may cause SoftWave to miss the signal completely.  To avoid this 
potential problem, tune the receiver so that the signal is centered on the filter.  The 
easiest method of centering the signal is by using the spectrum analyzer in the 
Communications Radio.  Remember to switch out of CW-TT while you’re trying to 
find the signal and then jump back in when you’ve centered on it. 
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OPTIONS 
 
SoftWave provides several options to make shortwave and VHF listening easier for 
the user.  To review the options available, select Options at the top menu bar.  A 
drop down menu will appear listing the options. 
 

 
 
 
 
Mute Sound 
 
This menu option simply provides an easily keyboardable method for muting the 
audio.  You can also mute by clicking on the mute button in the lower left portion of 

the screen.   When the sound is muted, a red X will cover the button. 
 
 
Audio Loss 
 
The audio output may disappear for several reasons, not just mute.  These reasons 
are listed below.  If, after checking these items, you are unable to make the audio 
return, please call ComFocus technical support at the number listed in the front of 
the manual: 
 

The sound is muted (the mute button has a red X on it). 
The signal is squelched (squelch is on and the signal strength is below the 

squelch level) 
The RF Gain is too high (set the RF Gain all the way to the left to fix). 
The speaker is plugged into the wrong port in the DSP card (it should be 

plugged into the second port down from the top of the card). 
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Frequency Match 
 
Perhaps you are listening to a shortwave station and are curious about it’s origin.  By 
selecting the Frequency Match option you can quickly search SoftWave’s database 
of worldwide programming.  If the broadcast is included in the database the 
frequency match command will identify the station, language, origin, time of 
broadcast, target area and other interesting information.  See “Select Station” for 
more about the types of information displayed. 
 

 
 
If the station on which the receiver is tuned is not in the database, the above 
message will appear on the screen.  Note that the database was searched for the 
exact frequency tuned, plus or minus the IF filter bandwidth.  This powerful 
advantage means that you don’t have to be tuned precisely on the frequency in order 
to match up with the database. 
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Select Station 
 
The select station option gives the user access to SoftWave’s database of worldwide 
programming.  To start this option: 
 
1. Pull down the Options menu. 
2. Choose the Select Stations option. 
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Sorting the Database 
 
 
SoftWave’s database can be sorted a number of different ways.  The primary 
categories of sorting include Target Region, Country, Frequency and Type of 
Program.  To select one of the primary categories click on it. 
 
After the primary sort is selected, SoftWave gives the user a list of secondary sorting 
options.  The secondary sorting options are shown in the box in the top middle 
portion of the Select Station window.  For example under the Target Region category 
(shown above) the user can select from several choices, mostly continents.  These 
selections narrow the database further.  To select a secondary sort, use the mouse 
to click on the preferred item. 
 
The database can be further sorted by clicking on the "Preferred Only", "On-the-Air 
Now Only" or "On-the-Air during the next   ____  Hrs" options.  To select one of 
these options click on the box next to the desired item.  Note that the number next to 
the words  "On-the-Air during the next   ___  Hrs" can be changed by clicking in the 
box after the word "next" and typing the desired number.  The default number 
provided with SoftWave is 2. 
 
The Station Spreadsheet 
 
The station spreadsheet contains columns for: 

Preferred - will contain an X if you click in it.  This makes a station 
“Preferred”.  If you check the “Preferred Only” check box, the 
spreadsheet will contain only those stations which you’ve indicated 
as peferred. 

Station - The name of the broadcast.  If the broadcast is being carried by 
some other station the station name will appear in parentheis.  For 
example, if Radio Egypt decided to carry the BBC, the Station entry 
would show:  BBC (Radio Egypt) 

Content - this is the type of the program.  Ie. News, General, Music, etc.... 
Days - this contains a letter for each of the days of the week.  It may also say 

“Irregular” indicating that the broadcast is seasonal.  For example, 
Radio Australia broadcasts rugby games in a certain time slot on the 
day they were played.  If no game was played on a particular day, 
the broadcast does not occur. 

Times - UTC start and stop times 
Frequency - the frequency in kHz. 
 

Note that there are other columns which you can get to by using the horizontal scroll 
bar at the bottom of the spreadsheet.  These columns are: 
 

Quality - a bar graph showing the relative signal-to-noise ratio at that 
frequency.  This number is computed just before the station is 



52 SoftWave User’s Guide  
 

shown in the spreadsheet so it is real-time.  The greater strength the 
carrier has as compared to the noise, the better the radio. 

Target Region - where this broadcast is aimed. 
Language 
Country - of origin 
Transmit Location - for shortwave stations this is usually the same as 

country.  For AM stations, this is a city or state of origin. 
Entry Expiration - the date of expiration of the program the data came from. 

 
 
Selecting a Station 
 
Use the mouse to scroll up and down to view the stations in the database.  By 
clicking on a particular station it will become hilighted.  The receiver will not tune to 
this selected station unless the "Auto Tune" button is selected or the "Select" button 
is clicked. 
 
Remember that if you use the Auto Tune command you may first want to select the 
"On-the-Air Now Only" button.   
 
By choosing the Select button the receiver will tune to the selected station and return 
to the prior screen.   
 
The Close button will return you to the previous screen without selecting the currently 
hilighted station. 
 
 
Adding a Station 
 
The Add, Edit, and Delete buttons at the bottom of the dialog allow you to add your 
own entries to the database.  Note that you may only delete entries that you’ve 
added. 
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Miscellaneous Settings 
 

 
 
 
Spectrum smoothing coefficient: 
 
The narrowband spectrum analyzer on the Comm Radio applies a smoothing 
algorhythm.  The smoothing ensures that a jumpy carrier such as a CW signal stays 
on the analyzer’s plot long enough for you to visually identify it.  This does, however, 
make the analyzer seem a bit unresponsive at times.  Changing the coefficient will 
make the spectrum more or less responsive.  At .1 the spectrum is more responsive.  
At .9 it is less. 
 
 
Spectrum Analyzer Refresh Rate 
 
This setting determines the number of times per second SoftWave attempts to 
update the narrowband spectrum analyzer.  Note that your computer may not be able 
to update as fast as the setting is set.  You may set this from 0 to 18.  At a setting of 
0, the spectrum analyzer is turned off. 
 
 
Tuner Scroll Delay 
 
This number controls the speed of the tuner when you are holding the scroll thumb of 
the tuner scroll bar of center.  The default setting is 350 milliseconds.  This means 
that the tuner will increment once every 350 milliseconds (or 3x per second).  You 
may set this value anywhere from 55 ms to 65000 ms to suit your tastes. 
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HELP 
To access SoftWave’s on-line help, select "Help" at the top menu bar.  A drop down 
menu will appear. 
 

 
 
 
 
Repair Database 
 
SoftWave Version 1.0 includes a database of over 5000 AM and 3000 shortwave 
stations.  The AM database consists of the FCC Broadcast AM Database, and 
includes all stations in the US., Canada, Mexico, Cuba and the Caribbean.  The 
shortwave database includes the current program schedules of many worldwide 
broadcasters.  All of the program information was entered by ComFocus from 
program schedules provided directly by the host broadcaster. 
 
It is not possible to omit or edit the database provided by ComFocus.  However it is 
possible to add to the database.  Station information added by the user can be edited 
or deleted. 
 
In the event of a hard disk failure, computer power failure, or incident that affects 
your data, you may not be able to open the SoftWave database.  An appropriate 
message will appear and you will be given the opportunity of running the system 
without the database. 
 
SoftWave Version 1.0 includes a database repair system that can be initiated by 
selecting the Repair Database command on the Help menu.  To select the Repair 
Database command: 
 
1. Select "Help" at the top menu bar. 
 
2. Select "Repair Database".  The repair and re-compression functions could take 

several minutes, depending upon the size of the database. 
 



SoftWave Users Guide 55 

 

Frequency Chart 
 
For those of us who have not memorized the frequency assignments or privileges 
between 500 kHz to 30 MHz and 108 MHz to 174 MHz, SoftWave provides an easy 
to read frequency chart.  This colorful chart displays the assignments for frequencies 
which can be received by SoftWave.   
 
To open the Frequency Chart: 
 
Select "Frequency Chart" from the Help menu. 
 
 

 
 



56 SoftWave User’s Guide  
 

INDEX 
 
ABBR Decode, 44 
Accumulate, 39 
AFC Enable, 44 
AGC, 28 
AM Demodulator, 22 
AM Radio, 15 
AM-Syn Demodulator, 22 
Assign Split, 32 
Audio Controls, 24 
Audio Loss, 48 
 
BFO, 29 
Blanker Controls, 25 
 
Calibrate, 29 
Character Error Rate, 45 
ComFocus Sales, 2 
ComFocus Service, 2 
Communications Radio, 19 
CW - Narrow Band Demodulator, 23 
CW - Tone Tag Demodulator, 23 
CW Demodulator, 22 
 
Database, 17, 51 
Decode, 42 
Detection Threshold, 33 
DSP Board, 7 
Dwell Time, 34 
Dwell until Signal Loss, 34 
 
Exit, 13 
 
FM-PLL Demodulator, 23 
FM-XP Demodulator, 23 
Frequency Chart, 55 
Frequency Match, 49 
 
Getting Started, 4 
 
IF Filter, 27 
Installation, 7 
 

Lockout, 33 
Log File, 45 
LSB Demodulator, 23 
 
Max Hold, 39 
Morse Code Menu, 43 
Morse Code Translator, 42 
Mute Sound, 48 
 
No Sound, 48 
Notch, 28 
 
Options, 48 
Oscilloscope, 26 
 
Personalities, 15 
 
QSIG Decode, 44 
 
Receiver, 9 
Repair Database, 54 
RF Attenuator, 25 
RF Gain, 25 
 
Save Setup, 14 
Scan & Stop, 32 
Scanning Groups, 34 
Select Station, 50 
Select Stations Option, 21 
Sender Quality, 45 
Signal Constellation, 26 
Signal Loss Scanning, 34 
Software, 10 
Speaker, 9 
Spectrum Analyzer - Narrowband, 26 
Spectrum Analyzer - Wideband, 38 
Split Monitoring, 32 
Squelch Controls, 24 
System Requirements, 5 
 
Time Sync Radio, 40 
Timed Scanning, 34 
 



SoftWave Users Guide 57 

 

USB Demodulator, 23 
 
VFO, 29 
VHF RADIO, 31 
 
Warranty, 2, 3 
Word Guess, 43 
Words Per Minute, 45 
World Radio, 36 
 
Zoom-In, 46 
Zoom-Out, 46 
 
 


